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Krok prvni: Predstaveni systému LogiTouch
1. Co to viastné je?

Systém LogiTouch spojuje logické Fizeni, vizualizaci a ovladani do
jednoho kompaktniho celku. LogiTouch pfinasi pro vase aplikace vyssi
pfidanou hodnotu diky jednodusdimu vyvoji aplikace, pfehlednéjSimu
zobrazeni na grafickém displeji a intuitivnéjSimu ovladani dotykovou
obrazovkou. Jestlize jste zatim pouZzivali programovatelny automat PLC
a operatorsky panel, LogiTouch vam muaze nabidnout mensi potfebu
propojovani, usporu mista a v neposledni fadé nizsi naklady. Systém
LogiTouch pfichazi vjednom kompaktnim zafizeni. Velikost celého
systému je srovnatelna se stfedné velkym PLC. Instalace systému je
diky integraci vstupl a vystupl do téla zafizeni jednodussi a vyzaduje
mensi prostorové naroky nez systém s PLC a operatorskym panelem,
nebo systém s PLC a prepinadi, indikatory, zobrazovadi apod.

2. Kompletni nabidka

Kompletni fada systému LogiTouch obsahuje tfi modely:

typ A obsahujici 32 digitalnich 1/0O (16 vstupl a 16 vystup(),

typ B s pfipojenim k systému vzdalenych I/0O Flex Network,

typ C s prfipojenim k rozsifitelnému 1/0 systému Flex Network a
pfidavnym sériovym portem pro externi zafizeni, napfiklad fizeni teploty,
ménice frekvence apod.

terminaly z nabidky firmy TECON spol. s r.0. — Graphic Logic Controllers
firmy Proface v fadé GLC 2000.

3. Komu ma slouzit tato prirucka?

Tato pfiruka je uréena pro zakazniky firmy TECON spol. s r.o., ktefi
prichazeji poprvé do kontaktu se systémem LogiTouch typ A.

V zadném pfipadé tato atla pfirucka nemlze a nechce nahradit
uzivatelsky manual ke konfiguraénimu software LogiTouch Editor ani
manual hardwarovy k LogiTouch.

Autor tiSe predpoklada, ze ¢tenar je schopen spravné spustit pocitac PC
s operatnim systémem MS Windows, Ze dokaZze nainstalovat
konfiguraéni software LogiTouch Editor zdodaného CD a ke
komunikaénimu portu PC spravné pripojit konfiguraéni kabel systému
LogiTouch. Dale se pfedpoklada, ze uzivatel bude schopen spravné
pfipojit napajeni k systému LogiTouch a vstupnim a vystupnim zafizenim
systému.

4. Co budete potrebovat?

» systém LogiTouch,
tato pfiru¢ka je psana pro systém typu A, ale pro zvidavého ¢tenare jisté
nebude problém aplikovat uvedené poznatky na libovolny systém
LogiTouch.
instalaéni CD software LogiTouch Editor
konfiguraéni kabel pro komunikaci mezi PC a LogiTouch
kabel pro pripojeni vstupl a vystupt LogiTouch,
neni podminkou, uvedeny pfiklad Ize vytvofit i bez tohoto kabelu
napajeci zdroj 24 VDC
kfizovy Sroubovak

5. Co tedy chceme dosahnout?

Pomoci této pfirucky by se mél uzivatel seznamit se specificnostmi
systému LogiTouch, s typem jeho programovaciho jazyka a s konfiguraci
vizualiza€nich obrazovek. Tyto zaleZitosti budou pfedvedeny na pfikladu
s motorem, ktery je pfipojen k systému, je spoustén pomoci tlaCitka na
obrazovce a bézi po pfedem urCeny Cas, ktery je nastavitelny klavesnici
na obrazovce LogiTouch.
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Krok 2: HARDWARE

LogiTouch

Systém LogiTouch typ A, je kompaktni zafizeni obsahujici

- zobrazovaci jednotku — monochromaticky podsviceny modrobily LCD
displej srozliSenim 320 x 240 bodd, s nastavitelnym kontrastem
zobrazeni.

- vstupné vystupni systém s 16 digitalnimi vstupy a 16 digitalnimi
vystupy vyvedenymi v konektoru pro pfipojeni propojovaciho kabelu
a s indikaci sepnuti.

- konektor pro pfipojeni konfiguracniho kabelu pro nahravani a
monitoring celého projektu (logického fizeni i vizualizace)

- konektor pro pfipojeni napajeni 24 VDC

- prepina¢ STOP/RUN pro fizeni provadéni logického fizeni aplikace

- vystupni konektor ALARM, ktery je rozepnut v pfipadé abnormalnich
podminek provozu systému LogiTouch, nebo chyby v provadéném
programu a lze jej vyuzit k externi indikaci poruch nebo nouzovému
odstaveni technologie.

Krok 3: SOFTWARE
LogiTouch Editor

Systém LogiTouch se konfiguruje prostfednictvim software LogiTouch

Editor. Tento software zahrnuje:

- konfiguraéni software pro sestavovani grafickych obrazovek
vizualizace

- programovaci software pro sestavovani a ladéni programu

v liniovych diagramech

- software pro pfenos (transfer) projektu do systému LogiTouch

- software pro monitorovani procesu v liniovem diagramu a software
pro simulaci proménnych pro vizualizaéni ¢ast projektu.

Vlastnosti LogiTouch Editoru

Software LogiTouch Editor vychazi z osvédéeného nastroje GP-PR/PBIII
V5.0 pro konfiguraci paneli fady GP firmy Pro-face a nastroje Pro-
Control V3.0 pro grafické fidici terminaly GLC.

LogiTouch Editor je velice jednoduchy a intuitivni, protoZze automaticky
sdili databazi proménnych mezi vizualizaéni a Fidici ¢asti projektu.
Jednoduché prvky obrazovek jako jsou spinade a indika¢ni lampy je
mozné vytvaret pouhym pretazenim proménné zliniového diagramu
programu Vv Fidici ¢asti projektu.

Cely projekt (vizualizaci i Fidici program) je mozné prenést jednim
kliknutim mysi prostfednictvim jediného konfigura¢niho kabelu.

IE Tipy

Co je to proménna?

V systému LogiTouch jsou vSechny vstupy a vystupy a vnitfni pomocné
kontakty reprezentovany jako promeénné. Kazda proménna muize mit
pfifazeno jméno, pod kterym vystupuje v celém projektu.
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Krok 4: LogiTouch Editor Demo

Spuste program LogiTouch Editor z nabidky Start nebo prostfednictvim
ikony na pracovni plose:
i

Na obrazovce se objevi okno Project Manager — aplikace slouzici ke
spousténi jednotlivych moduld LogiTouch Editoru.

@ LegitouchEditor v 1o

A
Pro vytvofeni nového projektu kliknéte mysi na ikonu NEW,

Pojmenujte novy projekt v poli Description, napfiklad LT Demo a zvolte
zarizeni LogiTouch Type-A v poli Display Type.

(Mo x|
Diasoophon
||_ 1 [ wred or |
D T Carcel |

[Ll ol o achy T s

Extemal Devee Tyox

IF Tipy

External Device Type

Tato nabidka je pfistupna pouze pro LogiTouch systémy typu C, které
disponuji interface pro pfipojeni vstupl a vystupl sité FlexNetwork a
dalSiho zfizeni (external device) komunikujiciho po sériové lince.
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Po kliknuti na OK se objevi nasledujici dialogové okno. Kdyz spustite Logic Program Editor, oteviete také pomoci menu Data ->
Kliknéte na tlagitko Edit LogicProgram. Configure 1/0 okno konfigurace fyzickych vstup( a vystupu.
BT ) - |
LogiTouch Edit =TT i
ogil Ouc [LLn]) E ! _ .!.-:'-.l.n I
E dit LogicProgram E : ==
=
Edit Screen .E' lf
- 1T
Cancel | @ e
e
Jak vidite software pro konfiguraci programu v liniovych diagramech e
Logic Program Editor se spustil v novem okné. Pojmenujte fyzické vstupy a vystupy LogiTouch. V tomto pfikladu
I — Prvni a velice dilezitou v&ci, pouzuem_e Jgden fyZ|ckyvvlstup systému (napfiklad 11) Jgk? ¢idlo poru’chy
zaiel | ARBY LI He . " . motoru (je-li motor v pofadku bude tento vstup neaktivni, rozepnuty) a
=) w0 =l |=|=|aiC] s kterou v Editoru udélame je

jeden fyzicky vystup (napfiklad QO) ovladani motoru. Dvojité kliknéte
vedle vybraného bodu a zapiste jméno. Neni nutné cidlo ani motor
fyzicky pfipojit, pro demonstraci nam staci systémova reprezentace 1/0.

povoleni fyzicky pfipojenych
vstupl a vystupl systému
LogiTouch. Standardné& jsou

totiz tyto 1/O zakazany pro T EE— i)
— = .---:~I--.-:-=': B il
| Contrulbn Sen KKl L= ) Mo
1ll'l'|l;I|H'lq| i_:“ m 1
’ [ : |8 S
gy . - ......_.... E R o fopimmires (11 2 m =.. |
potfeby ladéni systému. " Paved  Fecerishestn | o & o |
Otevfete z menu nabidku Controler e o |
Setup prostfednictvim  polozek  has R E - T|
Controler -> Setup. T g oy Pk i ]
Hi
chtevhiném dialogovém okné A T | E;:u 1 0ty
zaskrtnéte volbu Enable 1/0. @ E
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Nyni vytvofime program v liniovém diagramu. Program bude mit dvé
pricky — rungy a bude nakonec vypadat nasledovné.

B Lagic Program Editor - LT_DEMD_A

Fis Edé View Semch Irqet Dats Conbols Help
Bl ve] | > A sleg] ] selole 1] 7] o G
-3/ #] alel | > v |a]n]e] 1]#]
Program Die pl =
|- START
Hart Sansor  TmeElapssd WioEnr
2 {1 ! {1 i
il OF il
Etart
| |
o
Desralinn Tires
Mualor TON | TimeElupeed 14
g | 1} i [k s
o soofpr ETfo o
- END
4 .
FEMD Py aiiiarg B ode

Abychom mohli vkladat instrukce potfebujeme dalsi volnou pfi¢ku —
rung. Kliknéte na tlagitko pro pfidani pficky Insert Rung j

—

—START

[

Jako prvni potfebujeme do programu vloZit tlagitko, kterym budeme
spoustét motor.

Kliknéte na ikonu pro vlozeni spinaciho, v klidu rozepnutého kontaktu
(Normally-open) 1—"'-
Kliknéte na kontakt v liniovém diagramu a pojmenuijte jej Start (kliknutim

IStarﬂ
2

Dale potfebujeme do podminky vlozit dva rozpinaci kontakty (Normally-
close) Contacts pro &idlo poruchy motoru a pro indikaci ukonceni
Casovani. Kontakty vlozené takto na pfiCku reprezentuji logickou funkci
AND — podminka bude spinéna jestlize bude sepnut kontakt Start A
SOUCASNE bude rozepnut tento novy rozpinaci kontakt. PouZijeme

tlagitko pro vlozeni rozpinaciho kontaktu |ﬁl Prvni rozpinaci kontakt

nad tlaCitko aktivujte zadavaci pole)

ponechme zatim nepojmenovany a druhy kontakt pojmenujme
TimeElapsed
Y
TimeElapsed Off
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Nyni vytvofime vystupni kontakt |2[ ktery bude aktivovan. jestlize
podminka sloZena pfed nim na pfi¢ce bude splnéna. Také jej zatim

{

nepojmenujeme

Dale vytvofime paralelni podminku ke kontaktu Start. Tato d&ast
podminky bude splnéna, kdyz bude aktivni kontakt Start NEBO tento
nové viozeny kontakt. Tato paralelni odboCka bude reprezentovat
logickou funkci NEBO &astéji nazyvanou OR.

Jednodusde uchopte mysi pficku nalevo od kontaktu Start a pfetahnéte ji
otart

Lo
napravo od kontaktu. Oiff .

Vznikne paralelni odbocCka pfFicky, na kterou vloZime dalSi spinaci
Start

on

kontakt ﬂ Opét ho zatim nechame nepojmenovany

Pojmenovani kontaktu

Pomoci mysi pfetahneme symboly z okna konfigurace vstupl a vystupu
pfimo do liniového diagramu. Uchopte popisek Sensor a pfetahnéte jej
do programu na prvni rozpinaci kontakt na prvni pficce. Vystup
,Q0.Motor“ pfetahnéte na zbyvajici volnd mista nepojmenovanych
kontaktl v diagramu.

|

SESFIBISSFFOSAFIOBES
K CEEARES o

| i
e [ie o= Qemd posi Sas [ewds [mw = s AT -L'l—u[
v o) ] e W] 0o | Y ) ) ) o s
8 & ot |
| B =
| ——
- Eme—— s

-

aj .
Hamm I3l Fi Ll ok e

Franrma

Prvni pficka bude tedy vypadat takto

Sersor TimsElapsed

| A1
LT

o

=lar

Mol

1
K
¥

on o )

Pretahovat proménné Ize také ze seznamu Variable List.
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Vytvofime druhou pfi¢ku. VioZte prazdnou pFicku tlaitkem j

Pis [l Y= Qeach pusd Duss  Lossde e

B avs| (e aaies] a8l AHelo 0.0 S | sl Gl

=i #| wl'e| =l=le|=] o] 1]%]

= reEig
i~ END

_.I i

Faarg 1 o o M g ] LagTmas Tpe-a
Vlozte spinaci kontakt 1—"[ 3 I Zatim nechte kontakt
nepojmenovany.

Nyni vlozime do programu instrukci spinaciho Casovace (On Delay
Timer) pomoci ikony L-J-'f-l a pojmenujeme jej OperationTimer

TR T
i'll rl'.:!- |
== Spinaci Casovac¢ funguje tak, Ze po aktivaci postupné
nacita milisekundové tiky az do prfednastavené hodnoty (PT), po té je
podminka splnéna a je vykonana instrukce na strané vystupu pficky.
Dvojité kliknéte na Cislo vedle popisku PT. Objevi se dialogové okno pro

zménu hodnoty proménné.

Format; IDecimaI Vl Help

D ata Yalue
Walue of 0k
IDperatiDnTimer —l

Cancel |
Change to
{5000 Apply |

Zapisté hodnotu 5000 do pole Change to. Casova¢ je ted nastaven na
5000 ms, tedy na 5 sekund.

Ted jesté vlozime vystupni instrukci na pravou stranu pficky Lo a

.

nechame jeji jméno zatim prazdné

IE Tipy

Spinaci Casoval lze také vlozit z menu sekvenci polozek Insert ->
Instruction -> Insert Instruction -> TON.

Instrukce ¢asovace musi byt pojmenovana jako proménna.

Prednastavena hodnota ¢asovace se udava v milisekundach.
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Proménné Ize v Logic Program Editoru pfetahovat také z jedné pficky do
druhé. Pietahnéte kontakt Motor do spinaciho kontaktu v druhé pficce a
kontakt Time Elapsed do vystupni instrukce.

Bl = o W 1 )]
'J."'r':I'_'I! s L4 e N = R

Wl

e hggag B Ll
re ’ vrwv v E i
Nyni by druha pficka méla vypadat takto. == Tipy
Proménna TimeElapsed byla vytvofena v prvni pfi¢ce jako interni
%0100 OperationTimer promeénna. Symbol Ize také pfetahnout ze seznamu proménnych —
Motar TOM TimeElapsed Variable List.
I— ——I o] ()
Ot S000PT  ETO Ot V okamZiku, kdy je soubor uloZen jsou symboly registrované v seznamu
proménnych automaticky importovany do systému pro tvorbu

vizualiza¢nich obrazovek — Screen Editor.

Pamatujte, ze soubor musi byt nejprve ulozen, aby se proménné
mohly sdilet mezi jednotlivymi aplikacemi LogiTouch Editoru.

-10 -
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Nyni se dostavame k tvorbé vizualizace — tvorbé grafické obrazovky pro
ovladani motoru s ¢asovym spinacem.

Spustte z okna Project Manageru aplikaci Drawing Board tlacitkem
Screen v fadku Editor:

Screen Alorm

[ e —— miils
e W e e [ P s e Eeibe bk = i : B = i
Dl e @ a8 B¢ | EEb ) e ain o infelcic FRYE | o G
M oADGGaMS,ERr WF B0 4 wltl ] e miue) ris)
2 -; g -
ap- EMD
o - P
o
"

I&™ Tipy

Nastavte si zobrazeni tak, aby okna aplikace Drawing Board a aplikace
Logic Program Editor bylo mozné zobrazit souasné na jedné
obrazovce, napfiklad tak jako na vySe uvedeném obrazku.

Vyberte kontakt Start zliniového diagramu Logic Program Editor a
pretahnéte jej do aplikace Drawing Board na novou zakladni obrazovku.
Zakladni (base) obrazovka se zobrazuje na displeji panelu.
V konfiguracni aplikaci Drawing Board vidite obrazovku pfesné tak, jak
bude vypadat ve skutecnosti (WYSIWYG).

[Tt il . alli =i
. g - o f8 = femn per [ Lamis p
D W@ Sd B B v | ] ol e 3] s o) T 5 e
B crdobaaasGaee 5h g 2 1 I el
| e -
- il L el i (ST
- ¥ |-' — ]
- : ’ ' . .
- ¥
(1] T
o L [
- ¥ |
a ¥ Y
=5 ]
= L]
- 1 -
-3 1] s
b Al
] L1 P [
! (1}
B il o
Yy
PEND
s | TN B - o g Wt .H-'[:
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KdyZ kontakt Start ,upustite na obrazovku otevie se dialogové okno pro
vkladani bitového tladitka Bit Switch Settings. Vyberte funkci
.Zvonkoveho tlagitka“ pro okamzité sepnuti - Momentary (dokud budeme
tlaCitko drzet, bude se pfenaset jeho hodnota jako sepnuto, kdyz jej
pustite, kontakt se opét rozepne) a umistéte tlaCitko na plochu
obrazovky - Place.

] el = ﬂ'i LR |rl|.‘-r.|'-'-

Pamatujte, Ze instrukce musi byt vybrana. Vybrani pouze jména symbolu
nestadi k pfetazeni.

V nabidce nastaveni tlacitka je mozné uzivatelsky pfizpUsobit tvar, barvy
i popisek tlacitka. Standardné se do popisku (Label) tladitka prenasi
jméno proménné.

Nyni pfetahnéte Casova¢ OperationTimer do okna kresleni vizualizace.

; : . Fo [l Bes jemeh pem fun omsis el

D@ w B Eh v @ e m e | e e gl S mieio o |0 Y e
OO0 kGO0 e 08 fm o 5 —||I|ﬂh| "I"l.'l'l"l'.'l.;lﬂ
. = = i - =
- ]
= i STAAT
@ r
i (]
L W =
fal 5 - ¥ u
=2 "
| # H
= ]
- ]
n m
w in
= i
- "
m "
= H !
5 LE -

if-EHD

FeRL
-

FURT | g depnrred Sk rﬂ

Kdyz je do okna kresleni pfetazen ¢asovac je automaticky rozpoznan a
objevi se dialogové okno pro konfiguraci zobrazeni vstupni hodnoty,
zadavané pomoci klavesnice — Keypad Input Display.

Pomoci vyskakovaci klavesnice (pop-up) muzeme dotykem na
obrazovce ménit pfednastavenou hodnotu Casovace
(OperationTimer.PT) a tim nastavovat dobu chodu motoru
v milisekundach.

-12 -
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V dialogovém okné Keypad Input Display vyberte zobrazovanou
adresu — Word Address — proménnou OperationTimer.PT.

(el Sl | Ciempiny Pt | B gDt |
Psacsis v el

AFe=ecie= =]
Eemaw |

|r‘|u.-ni|:urd||}n| |

MUzete jeSté zménit parametry zobrazeni pod zalozkou Display Format
a po té kliknéte na tlaCitko Place a umistéte vstupni displej na
obrazovku. Zakladni obrazovka bude tedy vypadat takto:

CLIETETON =10 x|

Dale umistime na obrazovku indikaci chodu motoru. Opét pouze
jednoduse pretahnéte vystupni instrukci Motor z liniového diagramu do
obrazovky vizualizace.

Systém detekuje, Ze se jedna o vystup a automaticky nabidne dialogové
okno pro konfiguraci svételného indikatoru Lamp.

Ve g | it ok | L |
MLumes 1 TR L
—— I S|
Tiam :'-I T
Fr—ip |
Pus Caca L]

Jako adresa je vam automaticky nabidnuta pFfenasena proménna
z liniového diagramu, v naSsem pfipadé proménna Motor. Umistéte
svételny indikator na obrazovku tlacitkem Place.

Jako posledni prvek této ukazkové obrazovky umistime numericky
zobrazovac¢ aktualni hodnoty Casovace, na kterém uvidime jak ¢asovac
nacita milisekundové intervaly az do pFednastavené hodnoty
OperationTimer.PT.

Z nabidky pfipravenych prvk( vizualizace v aplikaci Drawing Board

vyberte pomoci ikony 33 numericky displej Value Display.

V dialogovém okné pro konfiguraci zobrazovade vyberte v poli Word
Address pomoci Sipky doll proménnou OperationTimer.ET (aktualni
hodnota) a zobrazova¢ umistéte na obrazovku tlacitkem Place.

-13 -
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Zakladni obrazovka bude nakonec vypadat né&jak takto: Pojmenujte obrazovku €islem 1 do pole Screen a do pole Description
muzete napsat néjaky svUj popis podle kterého obrazovku v seznamu
BT Lntitledi® pak snadno najdete.

FRESET

Vlozené prvky mulzete jeSté na obrazovce pojmenovat pomoci nastroje

pro vkladani textu Il

Zakladni obrazovku ulozte bud ikonou s disketou, nebo prostfednictvim
menu [File] -> [Save]. Pfi prvnim uloZeni nové obrazovky se objevi
dialogové okno pro ocislovani a pojmenovani obrazovky.

[faveds |

Progac: Fila AT | oK. I

Sarivnsety T ot Fiars Scisan Carsl

oo e Lo

Diszcription | Linsitacii [@ Ti
Obrazovka s Cislem jedna je standardné urCena jako prvni, ktera se
objevi po startu systému na obrazovce LogiTouch (lze zménit

_ b | v nastaveni systému.
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Opustte aplikaci Drawing Board a Logic Program Editor, a kliknéte na

ikonu Transfer v Project Manageru. Objevi se nasledujici okno Transfer Settings |
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Nejprve v polozce menu Setup -> Trasfer Seting nastavte potfebné

parametry pro spojeni PC se systémem LogiTouch. Ostatni polozky nastavte podle predchoziho obrazku.

Nastaveni Transferu ulozte tlaCitkem OK.
Nejprve nastavte komunikaéni port pocitace ke kterému je LogiTouch

pfipojen konfiguranim kabelem. Maximalni rychlost pfenosu projektu je
115,2 kbaud.
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Transfer spustte tlacitkem ﬁl nebo z menu vyberte Transfer -> All
Send. Sledujte na obrazovce PC a LogiTouch probihajici pfenos.
Vyc€kejte nez se prenaseni projektu ukongi.

Po kompletnim ukon€eni pfenosu se LogiTouch resetuje a zobrazi
obrazovku vizualizace, tak jak byla nakonfigurovana. Piepinatem na
zadni strané LogiTouch pfepnéte systém do modu béhu programu RUN.

IE™ Tipy

Jestlize je spustén Transfer ikonou ﬁl je soucasné do LogiTouch
pfenaSen jak program logického fizeni, tak i obrazovkova data
vizualizace.

V pfipadé pouziti ,klasického* feSeni je nutné pfenadet zvlast data
vizualizace do grafického panelu a zvlast program do
programovatelného automatu PLC a to vétSinou dvéma rlznymi
software a riznymi kabely.

Ovérte spravnost funkce celého projektu:

1. Jestlize se dotknete tlacitka Start motor se spusti a to¢i se po
dobu uréenou prednastavenou hodnotou.
Jestlize mate fyzicky pfipojen motor k vystupu LogiTouch budete moci
sledovat skute¢né ovladani. V pfipadé, ze motor pfipojen nemate
sledujte indikator béhu motoru na obrazovce LogiTouch. Soucasné
muzete sledovat na zobrazovadi aktualni hodnoty Casovace jak
postupné narUstaji az k pfednastavené hodnoté. Soucasné by se méla
rozsvitit LED indikace vystupu na téle LogiTouch.

2. Nastavte pomoci obrazovky LogiTouch novou prednastavenou
hodnotu €asovace

Dotknutim se zobrazovale pfrednastavené hodnoty vyvolate

,vyskakovaci“ klavesnici na které zadejte novou pfednastavenou

hodnotu ¢asovace v milisekundach. Jestlize se spletete pouzijte tlagitko

CLR pro vymazani zadavané hodnoty. VloZzenou hodnotu potvrdte

tlaitkem Enter.

3. Opakujte krok 1. s novou prednastavenou hodnotou ¢asovace
a zkontrolujte zda je v8e v pofadku.

4. Néco nepracuje?

Jestlize Vas§ systém LogiTouch nepracuje tak jak je popsano vyse,
zkontrolujte, zda se projekt spravné prenesl z PC do LogiTouch, mate
v pofadku program logického fFizeni, LogiTouch je vmodu RUN a
obrazovka vizualizace je spravné nakonfigurovana. V pfipadé vétSich
probléml kontaktujte oddéleni technické podpory dodavatele, firmy
TECON spol. s r.o.
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